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StudentTracker Agreement for Outreach Programs (Agreement)

For good and valuable consideration, the receipt and sufficiency of which are hereby acknowledged, the National
Student Clearinghouse, a not-for-profit corporation organized under the laws of the Commonwealth of Virginia
(“Clearinghouse”) and the undersigned workforce program (“Program”) agree as follows:

5

NATIONAL STUDENT CLEARINGHOUSE OUTREACH PROGRAM

Kicardo ). Tornes 2/16/2024 Choryl Fullen 2/19/2024
Signature Date Signature Date
Ricardo D. Torres Cheryl Fuller
Name Name
CEO and President Vocational Rehabilitation Division Director
Title Title

Please return agreement and payment to:

National Student Clearinghouse
2300 Dulles Station Blvd., Suite 220
Herndon, VA 20171

Texas Workforce Commission-Vocational Rehabilitation
Division
101 East 15 Street, Ste 504T

Fax: 703-742-4234 Austin, TX 78778

Email: contracts@studentclearinghouse.org

1. The Clearinghouse provides a nationwide, central repository for student record data for postsecondary educational
institutions that have appointed the Clearinghouse as their agent for purposes of reporting the enrollment and educational
achievements of their students to authorized recipients.

2. At any time during the contract period, Texas Workforce Commission (TWC), a Texas state agency, and the the Vocational
Rehabilitation Program that operates as part of TWC (collectively, the “Program”) may submit to the Clearinghouse lists
(“Request Files™) of persons in order to obtain data on their enrollment status and educational achievements at educational
institutions. The Program agrees to format and submit Request Files in accordance with Clearinghouse published specifications
as provided in Attachment 3. Program wishes to obtain this data in order to evaluate its program and improve service delivery.
Program will append educational data received from Clearinghouse to individual records maintained by the Program and will
release information provided by Clearinghouse as part of that record in accordance with relevant laws and the confidentiality
provisions of 34 CFR Part 361 and 34 CFR Part 99, including, but not limited to, releases of data in response to a request from
law enforcement, a subpoena, or as part of aggregated data made available by the Program pursuant to TWC policies and
practices. Any release of this information provided without the data subject’s consent, other than releases to the data subject, if
identifiable, will be made in compliance with applicable laws and regulations. Clearinghouse will maintain information provided
in the Request Files in accordance with relevant laws and the confidentiality provisions of 34 CFR Part 361 and 34 CFR Part 99
and will not be re-released to any entity without an allowable justification or the express written consent of the identified
individual.

3. The Clearinghouse will promptly compare Request Files with its database and provide the Program with information (“Response
Files”) on the enrollment and academic achievements of the individuals in the Request Files that are provided by postsecondary
institutions to the Clearinghouse. Characteristics and limitations on the use of the information in the Response Files are as
follows:

a. The Program agrees that its use of the data provided by the Clearinghouse is limited as follows: For the purpose of
completing mandatory reports and performing evaluations required by Workforce Innovation Opportunity Act; for internal
use by the Program; as well as for reporting aggregate data to the U.S. Department of Labor, U.S. Department of Health and
Human Services, U.S. Department of Agriculture and the U.S. Department of Education. In addition to these federal
agencies, data that includes both aggregate and identifiable data provided by the Clearinghouse may be disclosed to Texas
Health and Human Services Commission, the Texas Education Agency, and the Texas Higher Education Coordinating
Board to accomplish joint objectives described in the laws of the State of Texas.

b. Except as provided above, TWC and the Program may not, under any circumstances, re-release data provided by the
Clearinghouse on individual students for the purpose of educational, employment, or similar verification, or aggregate totals
of students attending specific postsecondary institutions, without the Clearinghouse’s express written permission and
payment of any additional fees that may be required. The data, in aggregate form, may be used in conjunction with other
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collected data and shared with funding entities; published on the Program’s websites; in higher education and research
journals, or papers; or presented in higher education or research forums.

The Program agrees that it will not release data provided by the Clearinghouse to any other individuals, institutions, or
organizations, other than those identified above, either in student or institution identifiable form, without the Clearinghouse’s
express written permission.

RESERVED

The Clearinghouse will never release or confirm Social Security Numbers, but may mirror the input provided by
Program. If provided by Program, the Clearinghouse may use Social Security Numbers for the purpose of matching
records. If Program elects to submit Social Security Numbers to the Clearinghouse, Program agrees it shall always
obtain the student’s signed and dated written consent allowing the school to release the specified degree information
to the Program. The Program will provide the Clearinghouse a sample consent form prior to providing the
Clearinghouse with Social Security Numbers for the purpose of matching records. The Program agrees that so long
as this Agreement remains in effect it will maintain each student’s written consent to release the requested
information in a medium that may be retrieved in a recognizable form for two years from the date of the consent and
will provide a copy of such consent to the Clearinghouse upon request. The Program agrees further that it will
provide the Clearinghouse with a copy of every remaining consent to release information upon termination of this
Agreement if requested by the Clearinghouse.

The Program understands that it is solely responsible for ensuring that its consent form meets FERPA requirements
for consent to release of education records. In the absence of proof of consent, the Clearinghouse will release to the
Program only unblocked directory information, as defined in FERPA.

The Program may use the Clearinghouse’s StudentTracker website to track the enrollment status and educational
achievements of its students, for program evaluation and reporting purposes, following procedures reasonably required by
the Clearinghouse described in Attachment 3. In that situation, the Program agrees to ensure that their authorized personnel
utilize the Clearinghouse’s secure website only for the purposes of enrollment and academic achievement information for
their program’s participants or for the purposes detailed in Section 3.a-b.

The Clearinghouse agrees to destroy all personally identifiable, non-directory information received from the Program when
it is no longer needed for audit or similar regulatory purposes.

Both parties understand that the purpose of this study includes a longitudinal evaluation of the outcomes of Program
iniiatives, and as such there is no firm end date for the studies. Clearinghouse acknowledges that TWC maintains a
database used for research purposes, including longitudinal studies, and that information obtained from Clearinghouse
and appended to customer files will be maintained in that database. These records will be retained and subsequently
destroyed in accordance with the policies and procedures applicable to the individual records and that database,
including the record retention schedules dictated by the Texas State Library and Archives Commission.

4. The Clearinghouse specifically disclaims any responsibility or liability for errors or omissions in information provided by
educational institutions, including direct, indirect, incidental, special, or consequential damages resulting from the
Program’s use of information released by the Clearinghouse under this Agreement unless related to the intentional acts or
omissions of Clearinghouse. As a governmental entity organized under the laws of Texas, Program will not be liable for
any incidental, indirect, special, or consequential damages under contract, Tort, (including negligence), or other legal
theory. Program's liability to Clearinghouse and it’s officers, agents, employees, representatives, contractors, asssignees,
andor/or designeeds under the Agreement will not exceed the total charges to be paid by Program to Clearinghouse under
the Agreement.

a.

CLEARINGHOUSE SHALL INDEMNIFY AND HOLD HARMLESS PROGRAM, AND/OR THEIR OFFICERS,

AGENTS, EMPLOYEES, REPRESENTATIVES, CONTRACTORS, ASSIGNEES, AND/OR DESIGNEES FROM
ANY AND ALL THIRD PARTY LIABILITY, ACTIONS, CLAIMS, DEMANDS, OR SUITS, AND ALL
RELATED COSTS, ATTORNEY FEES, AND EXPENSES ARISING OUT OF, OR RESULTING FROM ANY
INTENTIONAL ACTS OR OMISSIONS OF CLEARINGHOUSE OR ITS AGENTS, EMPLOYEES,
SUBCONTRACTORS, ORDER FULFILLERS, OR SUPPLIERS OF SUBCONTRACTORS IN THE EXECUTION
OR PERFORMANCE OF THE AGREEMENT AND ANY PURCHASE ORDERS ISSUED UNDER THE
AGREEMENT. THE DEFENSE SHALL BE COORDINATED BY CLEARINGHOUSE WITH THE OFFICE OF
THE ATTORNEY GENERAL WHEN TEXAS STATE AGENCIES ARE NAMED DEFENDANTS IN ANY
LAWSUIT AND CLEARINGHOUSE MAY NOT AGREE TO ANY SETTLEMENT WITHOUT FIRST
OBTAINING THE CONCURRENCE FROM THE OFFICE OF THE ATTORNEY GENERAL.
CLEARINGHOUSE AND PROGRAM AGREE TO FURNISH TIMELY WRITTEN NOTICE TO EACH OTHER
OF ANY SUCH CLAIM.
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5. In consideration of the services provided by the Clearinghouse under this Agreement, the Program agrees to pay the
Clearinghouse a fee corresponding with the subscription level utilized by Program in accordance with the StudentTracker
for Outreach Programs Pricing Schedule (Pricing Schedule) provided in Attachment 1 for the first year of service and
agrees to pay the Clearinghouse the annual fee in accordance with the Pricing Schedule for the subscription level utilized
by Program, until this Agreement expires or is terminated by either party in accordance with Section 10 of this Agreement.
Response Files will not be released until payment is made.

6. This Agreement may be modified by written, mutual agreement of the parties and remains in effect until terminated by
either party, by providing thirty (30) days written notice to the other party. The Clearinghouse may not assign this
Agreement to a successor or wholly owned subsidiary without consent of Program, which Program will not unreasonably
withhold, and shall provide the Program at least sixty (60) days advance notice of any assignment, and require any assignee
to abide by all the terms of this Agreement.

7.  The Clearinghouse uses its best efforts to review, interpret and follow publicly-disseminated guidance on FERPA in the development
and operation of StudentTracker and provides for the release of only unblocked directory information, unless FERPA authorizes
release without consent. The Program is solely responsible for its compliance with FERPA, and the Clearinghouse is not liable for
any errors or omissions by the Program in using StudentTracker that may give rise to FERPA violations. Both the Clearinghouse
and the Program agree to comply with all applicable Federal, State, and local statutes, regulations, and other requirements pertaining
to the security, confidentiality, and privacy of information maintained by the Clearinghouse.

8. RESERVED

9. The Clearinghouse will comply with the requirements of Texas Business and Commerce Code, Chapter 521 relating to the
Unauthorized Use of Identifying Information. Tthe Clearinghouse shall provide the Program the notice described in Texas
Business Commerce Code Section 521.053(c) within twenty-four (24) hours of discovering a breach if Sensitive Personal
Information provided by the Program was acquired or is reasonably believed to have been acquired by an Unauthorized Person.
The Clearinghouse shall provide notice to the Chief Information Security Officer via email sent to ciso@twc.texas.gov. The
Clearinghouse agrees to take all necessary steps and pay all expenses to comply with the requirements of Texas Business
Commerce Code, Chapter 521 to address and remediate any breach of the information provided by the Program to the
Clearinghouse. For the purpose of this provision, the defined terms in this provision have the meaning as follows:

a. Sensitive Personal Information means an individual’s first name or first initial and last name in combination with any one
or more of the following item: (i) social security number; (ii) driver’s license or other government-issued identification
number; (iii) date of birth; or (iv) information that identifies the individual’s physical or mental health or provision of health
care to the individual.

b. Unauthorized Person means any person accessing or copying Sensitive Personal Information for an unauthorized use or
purpose, including access by a Clearinghouse employee or agent beyond the scope of access granted to fulfill this
Agreement.

10. Term and Termination.

a. Term. This Agreement shall begin on the date of last signature for one year. This Agreement may renew on its own
terms for four (4) successive one- (1-) year renewal periods unless sooner terminated by the parties in accordance
with the provisions in Section 10.b below.

b. Termination.

i. This Agreement shall not be construed as creating a debt on behalf of Program in violation of Texas
Constitution Article III, § 49a. Clearinghouse understands that all obligations of Program under the Agreement
are subject to the availability of state funds.

ii. Termination for Cause: Program may immediately terminate this Agreement and/or any PO issued under it,
in whole or in part, without recourse or penalty, for breach of contract by the Clearinghouse.

iii. Termination for Convenience: Program may terminate this Agreement and/or any PO issued under it, in
whole or in part, without cost or penalty, by providing thirty (30) days’ advance written notice, if Program
determines that such termination is in the best interest of the state.

iv. Inthe event of such termination under 10.b.ii or 10.b.iii, Clearinghouse must, unless otherwise mutually agreed
upon in writing, cease all work immediately upon the effective date of termination. Program and the State of
Texas shall be liable for payments limited only to the portion of work Program expressly authorized in writing
and which Clearinghouse has completed, delivered to Program, and which has been accepted by Program in
Revised 11/15/17 Copyright 2011 National Student Clearinghouse®. All rights reserved. Page 3 of 4
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writing. All such work shall have been completed, in accordance with contract requirements, prior to the
effective date of termination. Program and the State of Texas shall have no other liability, including no liability
for any costs associated with the termination.

11. Audit.

a. Program’s Right to Audit: Clearinghouse and any subcontractor shall make available at reasonable times and upon
reasonable notice, and for reasonable periods, all documents and other information related to this contract, including
but not limited to work papers, reports, books, records, and supporting documents. Clearinghouse and any
subcontractors shall provide Program with any information that Program deems relevant to any investigation or audit.
Clearinghouse must retain all work and other supporting documents pertaining to this Agreement, for the purposes of
inspecting, monitoring, auditing, or evaluating by Program. For the purpose of this section, Program’s right to audit
extends to any agency of the Federal government or State of Texas authorized by law or Program, including an
investigation or audit by the State Auditor or the Comptroller General of the United States.

b. Texas State Auditor. Pursuant to Texas Government Code §2262.154, the State Auditor may conduct an audit or
investigation of any entity receiving funds from the State directly under the contract or indirectly through a subcontract
under the Agreement. The acceptance of funds directly under the Agreement or indirectly through a subcontract under
the Agrement acts as acceptance of the authority of the State Auditor, under the direction of the legislative audit
committee, to conduct an audit or investigation in connection with those funds. Under the direction of the legislative
audit committee, an entity that is the subject of an audit or investigation by the State Auditor must provide the State
Auditor with access to any information the State Auditor considers relevant to the investigation or audit.
Clearinghouse and any subcontractor shall cooperate with any authorized agents of the State of Texas and shall provide
them with reasonably prompt access to all requested information and materials. Clearinghouse’s failure to comply
with this Section shall constitute a material breach of contract and shall authorize Program and the State of Texas to
immediately assess appropriate damages for such failure.

Clearinghouse shall ensure that this provision concerning the State’s authority to audit funds received indirectly by
subcontractors through Clearinghouse and the requirement to cooperate is included in any subcontract it awards.

12. Dispute Resolution Procedures. Disputes arising under this Agreement shall be resolved in accordance with the dispute
resolution process provided in Texas Government Code Chapter 2260.

13. Governing Law and Venue. This Agreement shall be governed, construed, and interpreted under Texas law, without regard
to the conflicts of law provisions. Clearinghouse agrees that proper venue for a claim arising under this Agreement shall
be brought in a court of competent jurisdiction in Travis County, Texas after the Dispute Resolution Procedures in Section
12 of this Agreement are exhausted or if that provision is not applicable to the claim.

14. No Waiver. Nothing in this Agreement shall be construed as a waiver of Program’s or the State’s sovereign immunity. The
Agreement shall not constitute or be construed as a waiver of any of the privileges, rights, defenses, remedies, or
immunities available to Program or the State of Texas. The failure to enforce, or any delay in the enforcement, of any
privileges, rights, defenses, remedies, or immunities available to Program or the State of Texas under this Agreemnt or
under applicable law shall not constitute a waiver of such privileges, rights, defenses, remedies, or immunities or be
considered as a basis for estoppel. Program does not waive any privileges, rights, defenses, or immunities available to
Program by entering into this Agreement or by its conduct prior to or subsequent to entering into this Agreement.

15. Both parties agree to provide all notices under this Agreement to the appropriate contact listed in Attachment 2 for Program
and to the signatories as listed in the Preamble for Clearinghouse, unless otherwise instructed in writing.

Enclosures:

Attachment 1, StudentTracker for Outreach Programs Pricing Schedule
Attachment 2, StudentTracker Program Contact List
Attachment 3, Creating StudentTracker® Non-Consent Based Request Files Using Excel
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Attachment 1:
StudentTracker Agreement for Outreach Programs

StudentTracker for Outreach Programs Pricing Schedule
Published July 31, 2012 and Effective Until Further Notice

Outreach Programs will pay an annual subscription fee for participation in the StudentTracker for
Outreach Programs service, equal to one of the following (depending on the size of the program):

Small Program: $595 per year
e Data File Limit: 12 submissions
e Annual Record Limit: 5,000 records
e Maximum Web User Accounts: 5 users

Medium Program: $1,000 per year
e Data File Limit: 15 submissions
e Annual Record Limit: 10,000 records
e Maximum Web User Accounts: 10 users

Large Program: $2,500 per year
e Data File Limit: 20 submissions
e Annual Record Limit: 20,000 records
e Maximum Web User Accounts: 15 users

Page 1 of 1
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Attachment 2

STUDENTTRACKER
CONTACT LIST

Organization Name: Texas Workforce Commission

*Executive Contact

Name: _Cheryl Fuller Title: _Vocational Rehabilitation Division Director

Email Address: _cheryl.fuller@twc.texas.cov_ Phone Number: 512-936-3701

*Billing Contact
(Person to receive billing invoice)

Name: APPO Title:  Accounts Pavable

Billing Address: _101 East 15" Street, RM 446, Austin, Texas 78778-0001

Email Address: _appo@twec.texas.gov Phone Number: _800-628-5115

Secondary Billing Contact

Name: Bree Slubar Title:  Contract Manager

Billing Address: _101 East 15" Street, RM 446, Austin, Texas 78778-0001

Email Address: _bree.slubar@twc.texas.cov Phone Number: _(737)400-5457

*Technical Contact(s)
(Person(s) responsible for creating, sending and receiving file data)

Name: Elsa Y. Perez Title: _Program Manager for Business Systems
Email Address: elsa.perez@twc.texas.gov Phone Number: 512-936-3757

Page 1 of 2
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*Additional Point of Contact

Name: Bree Slubar Title: Contract Manager

Email Address: bree.slubar@twc.texas.cov  Phone Number: (737) 400-5457

Chief Information Security Officer

Lance Leatherwood, CISSP (sc):

Chief Information Security Officer

ciso@twc.texas.gov

Texas Workforce Commission

101 E. 15t Street, RM 0330B
(737) 285-3377

With a copy to:

Privacy Officer
risk.securitymanagement@twc.texas.gov

and

Privacy Advisor
privacy.advisor@twc.texas.gov
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Creating StudentTracker Non-Consent Based Request Files Using Excel

(=% National Student
i June 23, 2021

Clearinghouse

Creating StudentTracker Research Files in Flat File Format

This guide will help you use Excel to format your StudentTracker graduates’ files. If you have questions or need
assistance, contact studenttracker@studentclearinghouse.org.

STEP 1: FORMAT COLUMNS A-L

e Open a new Excel spreadsheet and highlight columns A through L (columns will appear shaded).
e Under the “Format” menu, select “Cells.”
e Onthe number tab of the “Format Cells” window, select “Text” and click “OK.”

You MUST select text to retain the
leading zeroes in your SSNs, school, and
district codes.

Font | Border | Pattems | Protection |

Sample

Tiext format cels are treated as
text even when & mamber & in the

cel. The cell is displayed exactly as
entered.

Delete extra
worksheet tabs
by right clicking
each tab and
selecting
“Delete” from

the menu. "TEIT GE S S § el ) CTESTSRT - R SRS P LT
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STEP 2: ENTER DETAIL RECORDS FOR COLUMNS A-L BEGINNING IN ROW 2

Each student’s information should be entered in its own row. Columns marked with an asterisk (*) are

required.
e ColumnA =
e ColumnB =
e ColumncC =

e ColumnD
e ColumnE
Column F
e ColumnG

e ColumnH

D1*

leave blank

First Name*

Middle Initial (no periods)

Last Name*

Name Suffix (use letters not numbers, e.g., Jr, |, II, 111, IV, V)

Date of Birth in YYYYMMDD format*

IMPORTANT: Not required, but you are strongly encouraged to submit this data
element as the omission could impact your match rate.

Search begin date in YYYYMMDD format*

e Columnl = leave blank
e Column] = leave blank
e ColumnK = 00
e ColumnlL = Requestor Return Field.
Freeform field that allows you to enter values that are important to your
institution for performing additional analysis. We suggest using an underscore to
separate values. Do not use quotes, commas, or periods. Data is returned in the
Student Detail report. Note: Alpha characters are returned as capitalized letters.
Leave Middle Leave Leave
Blank Injtial Suffix Blank Blank
[ First \' Last .‘ |' DOB '}‘ Search " | Return "
| Mame | E Mame | ! Begin Date l Field
A B C D E F G H I J K L
2 DI Susie A Jones 19870605 20060907 00
3 D1 Jonathan Kim sr 19830803 20060914 ‘00
4 DI  Megan B Langley "19880314 20060901 00
l:haraii:‘r; u:har;ct-:-rs ::-ha:aL:::tﬁm c,har]ar:.ter lzhﬁ;-::-’[em charéctsrs char;ctsrs n:har;a:tsrs :har;z:ters char‘a?:ters

Allowed:

IMPORTANT

Do NOT use quotes, commas, or periods in any field.
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STEP 3: ENTER HEADER ROW COLUMNS A-G IN ROW 1

Insert a row above the detail records

Column A=H1
Column B = Account Number
Column C=00
Column D = Organization Name
Column E = File creation date in YYYYMMDD format
Column F = Inquiry purpose = DA
ColumnG=S
'| Sﬁ%ﬂ;gtr I'! I;"; Organization Name v""‘lll; Fileg;;teeation lI!
LA B C | D E E |G
1 |H1 123456 00 Educational Organization Name 20100201 DA S
Mazx. 6 40 3 2 1
Chf;gﬁfzzs characters characters characters characters characterscharacter

STEP 4: FORMAT CELL E1 & COLUMNS G-H

Select cell E1 and columns G-H (hold down the control key to make multiple selections).
Under the “Format” menu, select “Cells.”

Select “Custom” on the number tab.

In the “Type” field, enter YYYYMMDD and click “OK.”

T

A B C +] E G H
1 —
2 — =
3 Format Cells f-?i_]
4 usber | alonment | Fork | Border | Pl | Protection
\\ Gategery: |
L] | al Sampile
i \
e Cirrangy
- 1 Accounting Typa:
- ] Dste -
Time FYMNDD
10 —
Parcentage aenersl -
11 Fraction o
i Sciertfic 0,00
L2 || T #8220
13 N L £, #2000
Custom ] £, 880 18 2 00)
13 &, 820\ [Red)#, #20)
15 &, 220000 _);(#,280.00)
- £,#20,00_);[Red) 2, #.200.00)
16 §8, 880 Y158, £ ED)
17 §# 280 L [Red)ir, £20) b
15 | [elete |
13
0 Type the msvber Format code; wsng one of the exsting codes &5 a starting pont.
1
2
2 - *
2 Lo ][ cone |
5 — - —
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STEP 5: ENTER TRAILER RECORD IN THE LAST ROW

e ColumnA =Tl
e ColumnB = Row number of the trailer record (you must place the trailer record in the row
immediately following the last student data record row)
e ColumnC-L = Blank
A B C D E F G H 2 T s L
5115
Max 2 8
Characters characters characters
Allowed:

STEP 6: SAVE YOUR FILE

e In the File menu on the main toolbar, select “Save As.”

e On the “Save As” window, select the drive and/or directory where you would like to save the file.

e Enter a file name (your 6-digit entity code used in Row 1 Column B should be part of the file name).
e Select “Text (Tab delimited)” from the Save as Type drop-down menu.

e Click “Save.” Your file will be saved as a text tab-delimited file in the location you selected.

File name: 012345 4
Save astype! |TaxE(Tab delimited) ]

[” _S‘avéﬂi] [ Cancel

IMPORTANT
Do NOT use these characters in your filename: ' @ #$S% " & * () +
You can use underscores.

STEP 7: SUBMIT YOUR FILE

e Go to https://ftps.nslc.org/ to transmit your file to the Clearinghouse via your Secure FTP account.

If you do not have a Secure FTP account, email us at studenttracker@studentclearinghouse.org.

IMPORTANT
Do NOT email your files. This is not a secure method of transferring data.



